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What’s New In This Pre-Release?
Here’s a list of items new to Pre-Release 2 of Descent Studio:

· Double-clicking a HOG item creates an editor window for the item, if Descent Studio has a built-in 
editor for that item’s type. If it doesn’t have a built-in editor, then you will be given the opportunity to 
automatically export the item for use in another editor.

· Briefing (TXB) files can be edited. You can edit both external (standalone) briefing files as well as 
briefing files embedded in HOG files.

· A “Tip Of The Day” dialog gives you tips and tricks for getting the most out of Descent Studio.



What is Descent Studio?
Descent Studio is an editor for the files used to drive Descent. Descent is an 360º 3-D action/arcade 
game released by Interplay Productions and written by Parallax Software.

With Pre-Release 2, you can work with Descent’s HOG and TXB files. You can edit existing files and 
create new files. Future pre-releases will allow you to edit other types of files used in Descent. A new 
editor will be introduced with each pre-release.

Unlike other Descent editors, Descent Studio is a platform for editing many different types of Descent 
files. Some editors just edit levels, while others just edit briefing files. In its final incarnation, Descent 
Studio will be a platform where many Descent files — HOG files, briefing files, levels, and the like — can 
be edited using one familiar editing environment.

Most new pre-releases of Descent Studio will contain a new editor for a new Descent file type. Pre-
releases contain cumulative functionality; Pre-Release 3 will contain all of the features available in Pre-
Release 2 with the addition of the new functionality added for Pre-Release 3.



What’s Planned for the Next Pre-Release?
Descent Studio Pre-Release 3: MSN Files will feature mission file (MSN) editing. You will be able to 
work with external MSN files, and, as always, you’ll also be able to create new MSN files from scratch.

When you want to work with an external MSN file, you’ll be able to open it up with the Open command 
just as you open a HOG and TXB files now with Pre-Release 2.

No release date has been set for Descent Studio Pre-Release 3: MSN Files.



About the Author
Descent Studio was written by Jeff Ferguson using Microsoft Visual C++ and the Microsoft Foundation 
Classes. Jeff is a resident of Minneapolis, Minnesota, and has been programming professionally since 
1989. He has written programs in C and C++ for DOS, Windows and UNIX platforms.

Jeff is acting on his own in releasing Descent Studio and hereby takes full responsibility for the software. 
He is not affiliated with Microsoft, Interplay Productions or Parallax Software. Jeff clears these companies 
from any responsibility regarding Descent Studio.

Jeff would love to hear from people using Descent Studio. He is available on the Microsoft Network (msn)
as JeffFerguson. If you are not a member of msn, but you do have e-mail access to the Internet, you 
can write to him at JeffFerguson@msn.com.

Jeff is MiSTie number 54652. If you don’t know what that means, and phrases like “Hi-Keeba”, “Bite me” 
and “ThE mAsTeR wIlL bE vErY dIsTuRbEd” mean nothing to you, then it’s probably best not to ask for 
an explanation. It would take too long, and Jeff wants to spend his spare time making Descent Studio the 
best that it can be.



This field displays the name of the HOG item. Since Descent is a DOS game, and since Descent treats HOG items as
if they were standalone DOS files, HOG item names must be legal DOS filenames.



This field shows the starting offset (position) of the HOG item in the HOG file. HOG item offsets are zero-based, 
which means that the first byte in a HOG file is at offset 0.

Because of the structure of HOG files, the first item in a HOG file will not start at offset 0. If Descent Studio reports 
that a HOG item has an offset of 0, the item was pasted or imported from another source and the HOG file that 
contains the item has not been saved to disk since the item was added. This is normal; Descent Studio will correct 
the offset value when the item’s HOG file is saved.



This field shows the size of the HOG item, in bytes. If you export this HOG item to an external file, the external file 
will be of this size.



This list box shows the names of all of the HOG items that you have deleted since you last saved the HOG file. To 
undelete items, highlight one or more item names and press OK. To highlight more than one name, hold down the 
Ctrl key while you select names.



Menus
Descent Studio’s menu bar will change as you switch from one window to another. Each menu bar 
contains items applicable to the contents of the current window.

Menu Bar Contents When No Windows Are Active
Menu Bar Contents When HOG Windows Are Active
Menu Bar Contents When TXB Windows Are Active



Menu Bar Contents When No Windows Are Active
The following menus are available when no windows are active:

File menu
View menu
Help menu



Menu Bar Contents When HOG Windows Are Active
The following menus are available when a HOG file window is active:

File menu
Edit menu
Item menu
View menu
Window menu
Help menu



File Menu (No Active Windows)
When Descent Studio has no windows open, its File menu offers the following commands:

New Creates a new file.
Open Opens an existing file.
Print Setup Selects a printer and printer connection.
1, 2, 3, 4, 5, 6, 7, 8, 9 Opens a file that you opened in a previous session with Descent 

Studio.
Exit Exits Descent Studio.



View Menu (No Active Windows)
When Descent Studio has no windows open, its View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.



Help Menu (No Active Windows)
When Descent Studio has no windows open, its Help menu offers the following commands:

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New command (File menu)
Use this command to create a new file in Descent Studio. Select the type of new file you want to create in 
the File New dialog box.

Pre-Release 2 of Descent Studio can create new HOG and TXB files. Later pre-releases will let you 
create different types of files, such as RDL files.

You can open an existing file with the Open command.

Shortcuts
Keys: CTRL+N



Open command (File menu)
Use this command to open an existing file in a new window.    You can open multiple files at once.    Use 
the Window menu to switch among the multiple open files.    See Window 1, 2, ... command.

You can create new files with the New command.

Shortcuts
Keys: CTRL+O



Exit command (File menu)
Use this command to end your Descent Studio session.    You can also use the Close command on the 
application Control menu.    Descent Studio prompts you to save files with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.
Keys: ALT+F4



Print Setup command (File menu)
Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box
The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option and 
select one of the current installed printers shown in the box.    You install printers and configure ports 
using the Windows Control Panel. 
Orientation
Choose Portrait or Landscape.
Paper Size
Select the size of paper that the file is to be printed on.
Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.
Options
Displays a dialog box where you can make additional choices about printing, specific to the type of printer
you have selected.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.



File Open dialog box
The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the List 
Files of Type box. 
List Files of Type
Select the type of file you want to open.

Pre-Release 1 of Descent Studio can only open HOG files. Later pre-releases will allow you to open many
other Descent file types, such as TXB and RDL files.
Drives
Select the drive in which Descent Studio stores the file that you want to open. 
Directories
Select the directory in which Descent Studio stores the file that you want to open.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in Descent Studio, such as File Open.    A check mark appears next to the menu item when 
the Toolbar is displayed.

The Toolbar command affects the toolbar in Descent Studio’s currently active window. If Descent Studio 
does not have any windows open, then it affects the main toolbar.

See Also
Toolbar



Toolbar
The toolbar provides quick mouse access to many tools used in Descent Studio.

The main toolbar is displayed across the top of the main Descent Studio window, just below the main 
menu bar.

Descent Studio may create windows which have their own toolbar. They will all display at the top of the 
window, just below the window’s menu bar.

All of Descent Studio’s toolbars are moveable. To move a toolbar, click on an edge of the toolbar with the 
left mouse button. Keep the mouse button held down and drag the toolbar button to a new location. You 
can click on any area of a toolbar not occupied by a toolbar button when you want to move the toolbar.

Descent Studio’s toolbars can be docked to the window that the toolbar belongs to. To dock a toolbar, 
move the toolbar to one of borders of the window that the toolbar belongs to. Drop the toolbar into place 
when you move it to one of the borders, and the toolbar will dock itself to that window. You can prevent a 
toolbar from docking to a window border by pressing holding down the Ctrl key while the toolbar is being 
moved.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Also
Status Bar



Status Bar
The status bar is displayed at the bottom of Descent Studio’s main window.    To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Descent Studio and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of Descent Studio.



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last nine files you 
closed.    Choose the number that corresponds with the file you want to open.



File Menu (HOG Window Active)
When a HOG window is active, Descent Studio’s File menu offers the following commands:

New Creates a new file.
Open Opens an existing file.
Close Closes the active file.
Save Saves an opened file using the same file name.
Save As… Saves an opened file to a specified file name.
Print Prints a file.
Print Preview Displays the file on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
1, 2, 3, 4, 5, 6, 7, 8, 9 Opens a file that you opened in a previous session with Descent 

Studio.
Exit Exits Descent Studio.



Edit Menu (HOG Window Active)
When a HOG window is active, Descent Studio’s Edit menu offers the following commands:

Cut Deletes data from the file and moves it to the clipboard.
Copy Copies data from the file to the clipboard.
Paste Pastes data from the clipboard into the file.



Item Menu (HOG Window Active)
When a HOG window is active, Descent Studio’s Item menu offers the following commands:

Import… Import an external file into the HOG window.
Export… Export the highlighted HOG item to an external file.
Delete Delete the highlighted HOG item.
Undelete… Undelete one or more previously deleted HOG items.
Properties… View properties for the highlighted HOG item.

Import command (Item menu)
Use this command to import an external file into your HOG file.

A File Open dialog box will allow you to specify the file to be imported into your HOG file.

A copy of the imported file will be embedded in your HOG file. The original file that you imported will not 
be modified.



Export command (Item menu)
Use this command to export the highlighted HOG file to an external file.

A File Save dialog box will allow you to specify the filename for the exported file.

Exporting a HOG item creates a copy of the item as an external file. The item being exported will remain 
in the HOG file. Exporting a HOG item does not modify your HOG file.



Delete command (Item menu)
Use this command to mark the highlighted HOG item as deleted.

When you delete a HOG item, it will be removed from your HOG window. It won’t be permanently 
removed from your HOG file, however, until you save your HOG file.

You can undelete deleted HOG items before you save your HOG file.



Undelete command (Item menu)
Use this command to undelete HOG items that your have deleted.



Properties command (Item menu)
Shows the properties of the highlighted HOG item. The following properties are displayed:

· the name of the HOG item
· the zero-based offset of the start of the HOG item in the HOG file
· the size of the HOG item

If the highlighted HOG item was recently imported, but the HOG file that contains it has not been saved 
since the item was imported, then the HOG item  ’  s   offset will be shown as 0.

Shortcuts
Keys: ALT+ENTER



HOG Item
A file embedded in a HOG file. Descent HOG files are containers that hold several other files used by 
Descent, just as a ZIP file is a container that holds several compressed files. Descent Studio refers to 
each file embedded in a HOG file as a HOG item.



View Menu (HOG Window Active)
When a HOG window is active, Descent Studio’s View menu offers the following commands:

Toolbar Shows or hides the toolbar.
        Status Bar Shows or hides the status bar.



Window Menu (HOG Window Active)
When a HOG window is active, Descent Studio’s Window menu offers the following commands:

New Window Creates a new window that views the same file.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help Menu (HOG Window Active)
When a HOG window is active, Descent Studio’s Help menu offers the following commands:

Help Topics Offers you an index to topics on which you can get help.
About Displays the version number of this application.



Close command (File menu)
Use this command to close all windows containing the active file.    Descent Studio suggests that you save
changes to your file before you close it.    If you close a file without saving, you lose all changes made 
since the last time you saved it.    Before closing an untitled file, Descent Studio displays the Save As 
dialog box and suggests that you name and save the file.



Save command (File menu)
Use this command to save the active file to its current name and directory.    When you save a file for the 
first time, Descent Studio displays the Save As dialog box so you can name your file.    If you want to 
change the name and directory of an existing file before you save it, choose the Save As command.

Shortcuts
Keys: CTRL+S



Save As command (File menu)
Use this command to save and name the active file.    Descent Studio displays the Save As dialog box so 
you can name your file.    

To save a file with its existing name and directory, use the Save command.



Print command (File menu)
Use this command to print a file.      This command presents a Print dialog box, where you may specify the
range of pages to be printed, the number of copies, the destination printer, and other printer setup 
options.

Shortcuts
Keys: CTRL+P



Print dialog box
The following options allow you to specify how the file should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.
Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.
Print Range
Specify the pages you want to print:

All Prints the entire file.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.
Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog
The Printing dialog box is shown during the time that Descent Studio is sending output to the printer.    
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)
Use this command to display the active file as it would appear when printed.    When you choose this 
command, the main window will be replaced with a print preview window in which one or two pages will 
be displayed in their printed format.    The print preview toolbar offers you options to view either one or two
pages at a time; move back and forth through the file; zoom in and out of pages; and initiate a print job.



Print Preview toolbar
The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.
Next Page
Preview the next printed page.
Prev Page
Preview the previous printed page.
One Page / Two Page
Preview one or two printed pages at a time.
Zoom In
Take a closer look at the printed page.
Zoom Out
Take a larger look at the printed page.
Close
Return from print preview to the editing window.



Cut command (Edit menu)
Use this command to remove the currently selected data from the file and put it on the clipboard.    This 
command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+X



Copy command (Edit menu)
Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Paste command (Edit menu)
Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL+V



New command (Window menu)
Use this command to open a new window with the same contents as the active window.    You can open 
multiple file windows to display different parts or views of a file at the same time.    If you change the 
contents in one window, all other windows containing the same file reflect those changes.    When you 
open a new window, it becomes the active window and is displayed on top of all other open windows.



Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Arrange Icons command (Window menu)
Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open file window at the bottom of the main window, then some or all of the icons may not be 
visible because they will be underneath this file window. 



1, 2, … command (Window menu)
Descent Studio displays a list of currently open file windows at the bottom of the Window menu.    A check 
mark appears in front of the file name of the active window.    Choose a file from this list to make its 
window active.    



File Save As dialog box
The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a file with a different name.    A filename can contain up to eight characters 
and an extension of up to three characters.    Descent Studio adds the extension you specify in the Save 
File As Type box.
Drives
Select the drive in which you want to store the file.
Directories
Select the directory in which you want to store the file.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



HOG File Window
This window shows a HOG file that you have loaded into Descent Studio.

HOG items are shown in a tree format, separated out by their type. For instance, all of the PCX files in the
HOG file are placed under a folder called “PC Paintbrush Files”.

If a folder contains HOG items, it will be shown with a plus sign to its left. Double-click the folder or click 
the plus sign to open the folder and see its contents.

You an use the menu items or the toolbars to manipulate the contents of the HOG file.

See
importing a file into the HOG file
exporting a HOG item
viewing HOG item properties
deleting a HOG item
undeleting HOG items
cutting a HOG item to the Clipboard
copying a HOG item to the Clipboard
pasting a HOG item from the Clipboard
saving the HOG file
saving the HOG file under a new name
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License
Descent Studio Pre-Release 2: Descent/Descent 2 HOG and TXB Editor
Copyright © Jeff Ferguson 1996.
All rights reserved.

The Descent Studio Pre-Release 2 executables, help file and related text files may be distributed together
freely in an unmodified form and may be used without fee by any individual for non-commercial use, 
subject to the following terms:

Descent Studio Pre-Release 2 may not be sold or resold, distributed as a part of any commercial 
package, used in support of a commercial service, or used in any kind of profit-generating activity, even if 
it is being distributed freely, without the express written consent of Jeff Ferguson.

The integrity of the original Descent Studio Pre-Release 2 ZIP file (ds100p2.zip) as distributed by me is
essential. None of its contents may be modified, removed or added to in any way.

Descent Studio Pre-Release 2 is provided as is without warranty of any kind, either express or implied, 
including but not limited to the implied warranties of merchantability and fitness for a particular purpose. In
no event shall Jeff Ferguson be liable for any damages whatsoever including direct, indirect, incidental, 
consequential, loss of business profits or special damages, even if Jeff Ferguson has been advised of the
possibility of such damages.



File New dialog box

Specify the type of document you wish to create:

· Descent HOG File: Creates a new HOG file.
· Descent TXB File: Creates a new TXB file.



TXB File Window
This window shows a TXB file you have loaded into Descent Studio. The TXB window contains features 
that can help you in working with the codes used in Descent’s briefing files.

Inserting New Briefing Codes
Descent Studio does not require you to memorize obscure Descent briefing codes. You can select code 
descriptions from a list and have Descent Studio drop the corresponding code into your briefing text at the
current cursor position.

To automatically insert a new briefing code:

· Move the cursor to the point at which you want the new code to appear.
· Drop down the “Code” list box at the top of the window and select a briefing code.
· If the “Parameters” list box is enabled, then drop it down and select a parameter for the code. Note 

that not all codes have parameters. If you select a code that does not need a parameter, then the 
“Parameters” list box will be disabled.

· Press the “Insert” button.

You can always type codes manually, if you are sure of the code to be used.

Getting Descriptions Of Codes Already Used In Briefing Text
If you want to get a description of a code already appearing in briefing text, then move the mouse over the
code. A description of the code will appear on the TXB window’s status bar.



Menu Bar Contents When TXB Windows Are Active
The following menus are available when a TXB file window is active:

File menu
Edit menu
View menu
Window menu
Help menu



File Menu (TXB Window Active)
When a TXB window is active, Descent Studio’s File menu offers the following commands:

New Creates a new file.
Open Opens an existing file.
Close Closes the active file.
Save Saves an opened file using the same file name.
Save As… Saves an opened file to a specified file name.
Print Prints a file.
Print Preview Displays the file on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
1, 2, 3, 4, 5, 6, 7, 8, 9 Opens a file that you opened in a previous session with Descent 

Studio.
Exit Exits Descent Studio.



Edit Menu (TXB Window Active)
When a TXB window is active, Descent Studio’s Edit menu offers the following commands:

Undo Reverses the last editing operation.
Cut Deletes data from the file and moves it to the clipboard.
Copy Copies data from the file to the clipboard.
Paste Pastes data from the clipboard into the file.
Select All Selects all text in the edit window.



View Menu (TXB Window Active)
When a TXB window is active, Descent Studio’s View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.



Window Menu (TXB Window Active)
When a TXB window is active, Descent Studio’s Window menu offers the following commands:

New Window Creates a new window that views the same file.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help Menu (TXB Window Active)
When a TXB window is active, Descent Studio’s Help menu offers the following commands:

Help Topics Offers you an index to topics on which you can get help.
About Displays the version number of this application.

Undo command (Edit menu)
Use this command to reverse the last editing action, if possible. This command will not be available if the 
last operation cannot be undone.



Select All command (Edit menu)
Use this command to select all text in the edit window.




